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DVS Software User's Guide 
 

1 Introduction 
This guide is an overview on using the DVS1 software provided with your system.  
The DVS program allows the user to create a deployment file.  After creating a de-
ployment file (or loading an existing file) the DVS program will continue with the 
testing, deployment, and recovery of data. 

 
NOTE.  This guide covers DVS software version 1.05. 

 

 

CAUTION.  This DVS Software applies to DVS Phase I systems with firmware 
version 41.xx. For systems with 55.xx firmware, use the DVS Phase II software. 
The software is not backward compatible. 

 

1.1 How to Contact Teledyne RD Instruments 
If you have technical issues or questions involving a specific application or de-
ployment with your instrument, contact our Field Service group:  

Teledyne RD Instruments  Teledyne RD Instruments Europe 

14020 Stowe Drive 
Poway, California 92064 

 2A Les Nertieres 
5 Avenue Hector Pintus 
06610 La Gaude, France 

Phone +1 (858) 842-2600  Phone +33(0) 492-110-930 

FAX +1 (858) 842-2822  FAX +33(0) 492-110-931 

Sales – rdisales@teledyne.com  Sales – rdie@teledyne.com 

Field Service – rdifs@teledyne.com  Field Service – rdiefs@teledyne.com 

Client Services Administration – rdicsadmin@teledyne.com  
Web: http://www.rdinstruments.com 

24/7 Technical Support +1 (858) 842-2700 
 

                                                 
1 DVS is a registered trademark of Teledyne RD Instruments, Inc. 

mailto:rdisales@teledyne.com
mailto:rdie@teledyne.com
mailto:rdifs@teledyne.com
mailto:rdiefs@teledyne.com
mailto:rdicsadmin@teledyne.com
http://www.rdinstruments.com/
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1.2 System Requirements 
The DVS software requires a Windows® compatible computer with the following 
specifications: 

• Windows XP® or Windows 2000®   

• Pentium III 600 MHz class PC (higher recommended) 

• 64 megabytes of RAM (128 MB RAM recommended) 

• 50 MB Free Disk Space plus space for data files (A large, fast hard disk 
is recommended) 

• One Serial Port (two or more High Speed UART Serial Port recom-
mended) 

• Minimum display resolution of 1024 x 768, 256 color (higher recom-
mended) 

• CD-ROM Drive 

• Mouse or other pointing device 

1.3 Software Installation 
To install the DVS software, do the following. 

a. Insert the compact disc into your CD-ROM drive and then follow the browser 
instructions on your screen.  If the browser does not appear, complete Steps 
“b” through “d.” 

b. Click the Start button, and then click Run. 

c. Type <drive>:launch.  For example, if your CD-ROM drive is drive D, type 
d:launch. 

d. Follow the browser instructions on your screen. 

Once installed, you will have a shortcut added to your Windows® Start menu, RD 
Instruments folder and a desktop icon.   

1.4 Conventions Used in this Guide 
Conventions used in the DVS Software User’s Guide have been established to help 
you learn how to use these programs quickly and easily. 

Windows menu items are printed in bold: File menu, Exit.  Items that need to be 
typed by the user or keys to press will be shown as <F1>.  If a key combination were 
joined with a plus sign (<ALT+F>), you would press and hold the first key while you 
press the second key.  Words printed in italics include program names (DVS, 
BBTalk) and file names (test.dvs). 

Code or sample files are printed using a fixed font.  Here is an example: 
DVS 
RD Instruments (c) 2011 
All rights reserved. 
Firmware Version: 41.xx  
 
FIRMWARE BUILD: Nov  5 2011 02:18:41 
 
Closing recorder 
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You will find two other visual aids that help you: Notes and Cautions. 

 

NOTE.  This paragraph format indicates additional information that may help you 
avoid problems or that should be considered in using the described features. 

 

 

CAUTION.  This paragraph format warns the reader of hazardous procedures (for 
example, activities that may cause loss of data or damage to the ADCP). 

 

2 Using the DVS Software 
The program DVS is designed to take a user from the planning stage through data 
recovery. 

2.1 Starting the DVS Software 
a. In Windows, click Start, Programs, RD Instruments, DVS (default loca-

tion – use your installation settings if different).  The DVS software will start 
and display the DVS Wizard Startup Options screen. 

 

Figure 1. DVS Startup Options Screen 

b. The DVS Wizard Startup Options screen provides quick access to the most 
often used functions of the DVS software.  You may select one of the functions 
and click Next or click Cancel to begin using DVS.   

• Configure a DVS for a new deployment – This will create a new deploy-
ment file and start the deployment wizard (see Deployment Wizard). 

• Test a DVS– this will start the testing portions of the deployment wizard 
(see 5 Test the DVS). 
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• Recover data from a DVS’s recorder – This will open the recover data 
screen (see Recover Data). 

• Begin a terminal session with a DVS– This will open a terminal window 
and allow you to “talk” to the DVS unit (see DVS Terminal). 

2.2 Setup DVS RS232 Communication 
The DVS software assumes the last communication protocols configured are cor-
rect and opens directly to the DVS Wizard Startup Options screen.  However, 
the first time the software is run it is unlikely that the default protocols will apply.  
Therefore, on the first start up, do the following. 

a. Connect and power up the DVS unit as shown in the DVS User’s Guide. 

b. Start the DVS software. 

c. At the DVS Wizard Startup Options screen, click Cancel.   

d. From the Configure menu, click Serial Communications. 

 

Figure 2. Communication Setting - RS232 Configuration 

e. Select the COM port, baud rate, parity, and stop bits that the DVS unit is con-
nected to.  If you are unsure of the setting, click the Auto Detect button. 

f. Click Connect.  You should see the wakeup message appear on the deploy-
ment log window.  For example; 

DVS 
RD Instruments (c) 2006 
All rights reserved. 
Firmware Version: 41.xx  
 
Closing recorder 
 
g. Click OK. 

 

NOTE.  Once you establish communications with the DVS unit for the first time, 
the DVS software uses the same settings for future communications.   
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2.3 Configure the Inductive Modems 
This section describes how to setup communications with a DVS unit and how to 
verify communication with the inductive modems.  

2.3.1 System Setup 
The DVS system has an assumed bench top configuration consisting of a surface 
IMM (a Sea-Bird Inductive Modem) connected to a PC through a serial port and 
independently powered (i.e. by a 9V battery).  The surface modem is connected to 
a powered DVS device via the test cable.  See the DVS User’s Guide for an overview 
of the expected bench top setup for the DVS system.  

 

NOTE.  The modem communications have only been tested using Sea-Bird IMM’s 
with a firmware version of 0.99A or higher.  The surface IMM used to 
communicate with the DVS device will need to have this firmware version to 
ensure proper communications. 

 
Both the surface IMM and the IMM built into the DVS system can be configured 
with the DVS software.  The surface IMM will need to be configured using this pro-
cess in order for the software to successfully communicate with the DVS device.  
The DVS IMM is pre-configured upon delivery from Teledyne RD Instruments.  
However, this process can be run to ensure that the DVS device has the correct set-
tings or to reset it to a valid state if settings are changed accidentally.   

2.3.2 Configure Serial Connection to Surface IMM 
The first step is to configure the serial connection to the surface IMM.  

a. Connect and power up the DVS unit as shown in the DVS User’s Guide. 

b. Start the DVS software. 

c. At the DVS Wizard Startup Options screen, click Cancel.   

d. From the Configure menu, click Serial Communications. 

e. Select the appropriate COM port (i.e. the port that the surface modem is con-
nected to).   

f. For the baud rate, select 9600.  Serial communications with the IMM’s should 
always be set to 9600 baud.  

 

NOTE.  The inductive modems actually communicate with each other at a 
baud rate of 1200, and do not support communication with the DVS system at 
baud rates above 9600. 

 
g. Leave the other settings at their default values as shown in Figure 3.  
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Figure 3. Communication Setting – Inductive Modem Configuration 
 
h. Select the Using an Inductive Modem box and click the Get Modem ID 

button.   

 

NOTE.  You do not need to check the Using Inductive Modem box to specify the 
modem communication settings.  The DVS modem configuration process will fill 
in these settings for you. 

 
i. Press the OK button to close the Serial Communication Settings dialog.  

j. On the Configure menu, select Modems.  This will launch the dialog shown 
in Figure 4 below.  Select which modem(s) you wish to configure (i.e. the sur-
face IMM connected to the serial port and/or the DVS IMM).  

 

Figure 4. Configure Modems Dialog 

k. If you are configuring the DVS IMM, you have the option of Use Existing 
Modem ID, or Reset Modem ID (from 00 to 99).   
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NOTE.  The DVS Modem ID that is configured will be applied to the software 
serial communication settings for future modem communications.  
The DVS IMM can only be configured when it is the only device on the line.   

 
l. Press the Configure Modems button to start the configuration process. The 

dialog will update with a status bar and information on the configuration steps 
being run.  The configuration process will take a few minutes to complete.  
Once the process in completed, a message box will appear letting you know 
that the selected configuration(s) are completed (See Figure 5 below).  

 

Figure 5. Configuration Complete Message Box  

If the modem configuration process does not complete successfully, check the seri-
al connection from the PC to the surface IMM, and the connection to the DVS sys-
tem (if you are attempting to configure the DVS modem).  If the connections look 
correct and the modem configuration still fails, you will need to test your modem 
connections.  The DVS Operation Manual describes how to verify modem commu-
nications.  

3 Planning a Deployment 
The DVS software uses a wizard to step you through a series of self-explanatory 
pages to configure the desired profiling range and resolution, the number of en-
sembles per hour, and the time/date to start the deployment.  Once the planning 
portion of the wizard is complete, it leads to the Deployment Settings page 
where the final steps can easily be completed to deploy the DVS system. 

3.1 Saving Deployment Files 
Save the deployment file by clicking File, Save As.  This deployment file will save 
which steps have been completed in the Deployment Wizard.   

3.2 Opening Deployment Files 
To open a deployment file, on the File menu, click Open.  Select the deployment 
file to open and click Open.   

3.3 Deployment Wizard 
The DVS software lets you enter known or “best-guess” values for the various DVS 
system profiling parameters and shows predictions of expected results.  This lets 
you play “what if?” with the input parameters to evaluate trade-offs you may have 
to make with regard to standard deviation, profiling range, and timing. 

All new configurations start with the wizard.  The wizard guides you through ques-
tions about the environment, and how you want to setup the DVS unit.   
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The DVS software saves the profiling parameters, predicted consequences, and any 
notes you make in a deployment file.  The file is intended to configure a DVS unit 
for a deployment.  It is also a record of the configuration you chose.  

 

NOTE.  For more information about DVS system commands, see the DVS 
Operation Manual.   
The DVS software does not send the commands to the DVS until you are ready.  
Consequently, the DVS software can be run at your desk without a DVS unit 
connected. 

 
After completing the wizard, you can look at the parameters and/or edit them and 
see the consequences change.  When you are satisfied, you can save the changes to 
update the deployment file.  As you edit settings, the DVS software reviews your 
changes.  

3.3.1 Error Messages 
If you enter an illegal value, the DVS software displays an error message.  For ex-
ample, if you sent a command that specified too large a range to a DVS unit, it 
would reject the illegal command.  To prevent this, the DVS software displays this 
error message if you choose a range under 0.03 meters or over 5 meters.   

 

3.3.2 Warnings and Cautions 
The DVS software also displays warnings and cautions when a parameter is not 
advisable or is noteworthy.  For example, the length of a deployment may be lim-
ited by the amount of battery power in the DVS.  You can enter a longer deploy-
ment length, but if you do, the DVS software displays this message. 

 
Some messages may not appear until you reopen a deployment file.   

 

 

NOTE.  You must correct errors before you can continue.  You can save a 
deployment when a warning or caution is present.  

 

3.3.3 Using the Deployment Wizard 
To use the deployment wizard, do the following. 

a. Connect and power up the DVS system as shown in the DVS User’s Guide. 

b. Start the DVS software.   
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c. Start the Deployment Wizard by doing one of the following. 

• At the DVS Wizard Startup Options screen, click Configure an 
DVS for a New Deployment.   

• Click File, New Deployment (  on the tool bar).   

• If you are working with a deployment file (*.dvs), on the File menu, 
click Open. 

d. The first step is planning.  If you want to skip this step, check the Skip Plan-
ning Step box (see Figure 6), or click Next to continue. 

 

Figure 6. DVS Wizard - Deployment Planning 

e. Select the depth range (1 to 5 meters) you wish to measure (see Figure 7).   

f. Set the resolution (depth cell size) to between 0.03 to 5.0 meters.  A larger 
depth cell (bin) size decreases the standard deviation, but shallow water situa-
tions may need to use small depth cells (bins) to get more data points.   

g. Set the range to the 1st cell (blank) to between 0.03 (default) to 5 meters. 

h. The DVS software will automatically set the number of depth cells (bins) and 
show the first and last cell range.  Click Next. 



DVSTM Software User's Guide 

page 10 Teledyne RD Instruments 
EAR-Controlled Technology Subject to Restrictions Contained on the Cover Page. 

 

Figure 7. DVS Wizard – Water Profile 

i. Select how many ensembles per hour you want to record (Figure 8).  The DVS 
software will automatically set the time between ensembles.  Click Next.   

 

Figure 8. DVS Wizard – Measurement Frequency 

j. Enter the expected duration of the DVS deployment from the time of the first 
water profiling ping (either immediately or first ping date/time, see Figure 9).  
This duration does not produce a command to instruct the DVS to stop data 
collection; it is for estimating consequences only.  This duration is used to es-
timate the following consequences: Battery Power usage, and Storage required.  
Click Next to continue. 
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Figure 9. DVS Wizard – Deployment Date/Duration 

k. The DVS Deployment Settings screen opens using the settings you selected 
with the wizard.   

 

Figure 10. DVS Wizard – Deployment Settings 

Deployment Timing Setup 

• Start Date/Time - Ping Immediately After Deployment –  
Select whether to start the deployment immediately or delayed.  Un-
checking the box and entering a Start Date and Start Time in this 
field enables a delay from the start of a deployment to the first water 
profiling ping.  When enabled, the DVS system will begin collecting ve-
locity data at the date and time specified by the first ping date and 
time.  The DVS will sleep from the time the commands are sent to the 
DVS until the first ping date and time.  Make sure that the time is in 
the future and that the DVS clock is properly set. 
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• Duration – Enter the expected duration of the DVS deployment.  This 
duration does not produce a command to instruct the DVS to stop data 
collection; it is for estimating consequences only.   

Environmental Setup 

• Depth Rating – Select if the DVS is rated to 750 meters (Standard) or 
6000 meters. 

• Salinity – Fresh water is 0 and salt water is typically 35.  Salinity is 
used to calculate the speed of sound.  The speed of sound is used by 
the DVS unit to scale the velocity data properly.   

 

CAUTION.  If you use 0 for salinity when you deployed in water with salinity of 35, 
then your data will have a 3% velocity estimate error. 

 

• Transducer Depth – The DVS uses depth in its speed of sound cal-
culations.  If the pressure sensor is not available, then the DVS will use 
this manual depth setting. 

• Magnetic Variation – The DVS uses a flux-gate compass that 
measures magnetic north.  You must set the magnetic offset in order to 
obtain true north referenced velocity data directions.   

Profiling Setup 

• Ensemble Interval – This sets the (minimum) interval over which 
the DVS will collect and average the samples per ensemble and record 
data.  The format of this field is hh:mm:ss, where hh = hours, mm = 
minutes, and ss = seconds.  

• Samples Per Ensemble – Adjust the number of samples to get the 
desired Standard Deviation.  To increase the expected accuracy of the 
velocity measurement (reduce the Standard Deviation), you can in-
crease either samples per ensemble, bin size or both. 

• Number of Depth Cells – Sets how many depth cells (bins) are 
used.  The Last Cell Range field provides the last range that you have 
setup the system to collect.  To increase the Last Cell Range, enter 
more depth cells or increase the depth cell size.  A maximum of five 
depth cells can be used. 

• Pings Per Sample – displays the calculated Pings per Sample. 

• Depth Cell Size – Set the depth cell (bin) size. 

• Sample Interval – Selecting the Auto box will evenly space the 
pings throughout the ensemble, up to the maximum ping interval.  If a 
quick burst of samples is preferred, then the time between samples can 
be programmed directly by un-checking the Auto check box.    

 

NOTE.  A “sample” measurement from the DVS consists of as many 
measurements as can be made during one second; the exact number depends on 
several parameters, but is on the order of 100.  The minimum time between 
samples is therefore limited to one second. 

 

• Blank Distance – Moves the location of the first depth cell away 
from the transducer head. 
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Inductive Modem Setup 

• The Inductive Modem Setup allows evaluation of modem commu-
nications on power consumption; it does not configure the actual 
communications.  Enter a Data Transfers per Day value to see the 
Power Usage and Battery Used consequences.  All Inductive Mo-
dem communications are initiated from the surface modem, not the 
DVS. 

l. Review the following consequences.   

• First Cell Range – The range from the transducer face to the middle of 
the first depth cell (bin).  The depth cell (bin) size and the WF (blank) 
command in the command file primarily affect where it is located. 

• Last Cell Range – The last depth cell range is determined from the 
number of depth cells (bins), depth cell size, and first depth cell range. 

• Max Range – The maximum profiling range is dependent on the DVS 
frequency, water salinity, water temperature, and the depth of the 
DVS.  A warning message will appear if the maximum range exceeds 6 
meters (see Warnings and Cautions).   

 

Figure 11. DVS Deployment Consequences 
 

• Standard Deviation – Shows the expected standard deviation of the ve-
locity data stored in each ensemble being collected by the DVS.  Most 
users will want to minimize this value so that they obtain the best data 
possible (i.e. data containing the least amount of noise).  Standard de-
viation is dependent on depth cell (bin) size, the number of pings in an 
ensemble, the water mode, and the ambiguity velocity.  

• Ensemble Size – Shows the size in bytes of the each ensemble that is ei-
ther transmitted or recorded by the DVS.  

• Storage Required – Shows the amount of storage space required in 
megabytes (MB) to record the data generated by the DVS over the du-

Blank (0.03 to 5m)

Bin 1

Bin 2

Bin 3

Bin 4

Bin 5

Maximum Range 

0.3 to 5 m
per bin First Cell

Range

Last Cell
Range
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ration of the deployment.  This value should be compared to the free 
space available on the internal DVS PC card recorder and/or free space 
on the Computer logging the data transmitted to the serial interface.  
Free space on the DVS internal recorder can be determined by using 
the MM command (see Check the Recorder Status).  To convert MB to 
bytes, multiply the number by 1,048,576 (1024*1024).   

• Power Usage – The Power Usage will reflect how many watt-hours 
are required.   

• Battery Used – The Battery Used will reflect what percentage of the 
battery is used.   

m. Select the Show Commands box to view the commands generated by DVS.  
The commands shown in Table 1 explain each command set or added by DVS.  
These commands directly affect the range of the DVS, standard deviation (ac-
curacy) of the data, and battery usage.  Table 1 explains the commands used in 
the sample deployment file for a DVS.   

Table 1: Command File Created Using DVS 
Command Choices Description 

CR1 Sets factory defaults This is the first command sent to the DVS to place it in a “known” state. 

CF11100 Flow control Record binary data internally on the PC card recorder. 

TF060712080000 Time of first ping DVS will begin pinging on July 12, 2006 at 8:00 am. 

ES35 Salinity Salinity of water is set to 35 (saltwater). 

ED0 Transducer depth Manually set depth of the transducer.  If a pressure sensor is installed, 
the ED-command will be used only if the depth sensor fails. 

EB0 Heading bias Magnetic variation. 

TE00100000 Time per ensemble Ensemble interval is set to 10 minutes. 

WP1 Number of samples Number of samples is set to 1 

WN5 Number of depth cells Number of depth cells (bins) is set to 5. 

WS50 Depth cell size Depth cell (bin) size is set to 0.50 meters. 

TP100000 Time between samples The DVS software automatically sets the time between samples to 
spread the pings evenly throughout the ensemble. 

WF03 Blank after transmit Moves the location of the first depth cell more than 0.03 meters away 
from the transducer head.  The First Cell Rage is displayed under De-
ployment Consequences.   

CK Keep parameters as user 
defaults 

If power is lost and then restored, all commands will be restored as last 
sent. Sent right before the CS-command. 

CS Start pinging Last command sent to begin collecting data. 

 
n. Move the cursor to the Notes section.  Use the area to include notes about the 

deployment. 

o. Any step beyond this point requires communication with a DVS system.  If a 
DVS is not available, you can save this configuration for later use by un-
checking the Continue to deployment check box and clicking Next.  Oth-
erwise, you will be prompted to save the deployment file generated here, and 
will proceed to configuring the DVS for deployment (see DVS Deployments and 
Figure 13). 

p. Name the deployment file and click Save to save the deployment file (see Sav-
ing Deployment Files).  The DVS software will automatically add the extension 
*.dvs to the file.  
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3.4 DVS Deployments 
a. Connect the DVS unit to a computer running the DVS software via either the 

RS232 communications or the inductive modem.   

b. A command file must be loaded into the DVS software, either having been gen-
erated in the planning module (see Using the Deployment Wizard), or loaded 
directly from the File, Open menu.  In either case, the DVS software display 
should be at the Deployment Settings screen as shown in Figure 10.   

c. Check the Continue to deployment checkbox and click Next to reach the 
DVS Deployment screen shown in Figure 12. 

 

Figure 12. DVS Deployment Screen 

This screen contains the most commonly used “last minute” items done just prior 
to physically deploying the DVS unit.  These include: Set DVS Clock (usually to 
the time on the connected PC); Erase DVS Recorder (not selected by default to 
avoid inadvertent loss of data); selecting the diagnostic tests to be run, and De-
ploy DVS (which uploads the selected command file to the DVS unit).   

d. Select the Log results to file: check box and select a file name using the 
Browse button.  This will save the communications to the DVS to a text file. 

e. Once all of the desired options are checked, click the Next button.  
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Figure 13. DVS Wizard – Deployment 

f. A Results box will open and display the communications to the DVS in real 
time as the steps are run.  A green check mark next to each step indicates there 
were no problems; a red X indicates a problem or that the step was skipped. 

Once the commands have been sent to the DVS, proceed as follows. 

• Disconnect the test I/O cable and use the DVS User’s Guide to verify 
the DVS unit is sealed and ready for deployment.   

• Deploy the DVS. 
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4 DVS Terminal 
Use the DVS terminal screen to send any command to the DVS unit.  The com-
mands are listed on the left hand side of the window.  Selecting any of the com-
mands will display a definition of its use on the right-hand side, with options to 
choose depending on the command.   

a. Setup communications with the DVS. 

b. On the Tools menu, click Terminal. 

c. Click Send Break to wakeup the DVS unit.  For every break sent, you should 
see the wakeup message.   

d. Select the name of the command and parameters to be run.  Click the Send 
button.   

 

Figure 14. DVS Terminal Screen 
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5 Test the DVS 
Use the following steps to test the DVS. 

a. Connect and power up the DVS unit as shown in the DVS User’s Guide. 

b. Start the DVS program. 

c. At the DVS Wizard Startup Options screen, click Test a DVS.  Click Next.   

d. On the Test DVS screen, select Run All Tests (includes the recorder test) or 
Run Individual Tests and select the desired tests.  Click the Start Test but-
ton.  The selected tests will run (see the DVS Operation Manual for details on 
the test printouts).  A green check mark next to the test name indicates the test 
passed.  If a selected test fails, a red X will be placed next to the test name and 
a dialog box will prompt if you want to continue testing. 

e. The results of the test will be displayed in the Terminal Window area and 
saved to the log file (*.log) if the Log result to file box is selected.   

f. Click OK to exit the Test DVS screen. 

 

Figure 15. Testing the DVS 
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6 Recorder Functions 
The DVS software has the capability to recover and convert data, check the status, 
and erase the recorder. 

6.1 Recover Data 
Once you have recovered the DVS, you should refer to the Maintenance section of 
the Operation Manual for instructions on cleaning the DVS unit exterior.  Use the 
DVS software to recover the data once the DVS is clean and dry.  The DVS software 
reads the data from the DVS’s internal recorder and transfers the data to the com-
puter’s hard disk.  Select a directory name on the computer’s hard drive where the 
data will be written.   

 

NOTE.  It is highly recommended to use the test I/O cable and increase the 
baud rate to 115200 BAUD to reduce the download time.  Use external power 
to save battery power. 

 
a. Connect and power up the DVS unit as shown in the DVS User’s Guide.   

b. Start the DVS software.   

c. At the DVS Wizard Startup Options screen select Recover Data from an 
DVS’s Recorder or from the Tools menu, select Recover Recorder Data.   

d. Browse to an appropriate directory for the download.   

e. Select what Data to Download.  The options are to download averages of 
previous data collected, the last ensemble, command a new sample, or the en-
tire data set.   

f. Select the data format.  The raw data format is a compressed file format creat-
ed to minimize the memory requirements for the DVS unit and better accom-
modate long deployments.  The raw data stored can be converted to TRDI 
standard PD0 format on extraction, which can then be read by TRDI standard 
software tools such as WinADCP (see Convert Data). 

g. Click the Download… button to begin downloading data. 
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Figure 16. Recover Data Screen 

6.2 Convert Data 
The PD20 raw data format is a compressed file format that is not readable by 
WinADCP.  To convert the PD20 data to TRDI standard PD0 format, do the fol-
lowing. 

a. Recover the raw PD20 (compressed data) from the DVS recorder (see Recover 
Data). 

b. On the Tools menu, select Convert PD20 to PD0.   

c. Use the Browse button to locate the PD20 file to convert. 

d. Click Browse to select a folder and file name for the PD0 file.  Click Save. 

e. Click the Convert File button to begin the conversion. 

 

Figure 17. Convert PD20 File to PD0 
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6.3 Check the Recorder Status 
Use the Check Recorder Status functions to see how much memory is used on 
the recorder.   

a. Connect and power up the DVS unit as shown in the DVS User’s Guide. 

b. Start the DVS software.   

c. On the Tools menu, click Recorder Status.  This will open Recorder Sta-
tus screen (see Figure 18).   

d. Click the Get Status button.  

e. The results of the test will be displayed in the Recorder Status area and 
saved to the log file (*.log) if the Log result to file box is selected.   

f. Click OK to exit the Recorder Status screen. 

 

Figure 18. Recorder Status 

6.4 Erase the Recorder 
Once all data has been recovered, the recorder can be erased.  Once erased, the 
data is not recoverable. 

a. Connect and power up the DVS unit as shown in the DVS User’s Guide.  

b. Start the DVS software.   

c. Recover the data (see Recover Data).  Once erased, the data is not recoverable. 

d. On the Tools menu, click Erase Recorder Data. 

e. Type ErAsE (you must use the exact upper and lower case characters). 

f. Click OK. 
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Figure 19. Erase the Recorder 

 
CAUTION.  Data is not recoverable after erasing. 

 

7 Compass Alignment 
Compass calibration is an automated built-in test that measures how well the 
compass is calibrated.  The procedure measures compass parameters over 16 sam-
ples.  When it has collected data for all required directions, the DVS unit computes 
and displays the results. 

 

Figure 20. DVS Compass Calibration 
 

 

NOTE.  For step-by-step instructions on the compass calibration procedure, see 
the DVS Operation Manual. 

 



 DVSTM Software User's Guide 

P/N 95B-6037-00 (November 2011) page 23 
EAR-Controlled Technology Subject to Restrictions Contained on the Cover Page. 

8 DVS Software History 
Version 1.05 

• Adjusted power model to reflect actual usage (battery capacity reduced 
by 20% (180 Watt Hours versus 220 Watt Hours), and overall power 
consumption increased by 30%) 

• Fixed a Calendar control bug on Windows 7 

Version 1.04 

• Updated a warning about DVS not sleeping if TP<= 3.0s  

• Made it easier to enter custom sample intervals such as 00:02.00  

• Added ‘approx’ to the calculation of pings per ensemble  

Version 1.03 (internal TRDI release only) 

• Fixed problem with installation on foreign machines. 

• Added ability to set IMM communication time used in the power con-
sumption calculation. 

• Added display for calculated ‘Pings per Sample. 

• Changed warning font. 

• Added ability to send PC2 and PC4 commands over IMM. 

• Fixed problem with allowing disabled IMM commands when in lower 
case. 

• Added depth rating setting to DVS setup. 

Version 1.02 

• Fixed problem with TF format generated in the wizard  

Version 1.01 - Initial Release. 
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NOTES 
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